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Quick Operating Guide

Switch on: Press main button

Normal condition: Intermittent green LED flash and blip
Alarm condition: Fast flashing red LEDs and sounder
Alarm reset: Press main button

Activate backlight: Press any button

Switch instrument off: Press main and (=) buttons simultaneously
Zero instrument: Press lower ® button until bar on LCD

moves from Run to Zero, then push main
button to accept. If a key symbol appears on
the display a password is required.*

*NOTE: If the lower cursor does not move, the Functions Timeout option
has been enabled (see page 8).

INSTRUMENTS FITTED WITH INTERNAL PUMP

Switching pump on and off: Pump is activated and de-activated by fitting
or removing the flow adaptor.
NOTE: Do not connect to a pressurised gas cylinder with the pump
running

The transparent finger guard supplied allows access to the main button & (=
key. This restricts access to instrument functions but does allow the unit to be
switched on and off.
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2. Unpacking

Each Custodian is supplied in one or two boxes, depending on which options
and accessories have been ordered. Each box has a label detailing the
contents of the box. Should the contents not agree with the label, please
contact Crowcon immediately and have ready the serial number of the
instrument in question. The serial number can be found at the bottom of the
label on the rear of the main instrument. The battery pack has its own code
number found on the main battery pack label.

NOTE: When checking the contents of boxes, remove all items from the
foam packing and remove the foam. This will expose a false bottom
which can opened by inserting a finger in the hole provided and hinging
up. In most boxes, further contents will be found in this lower
compartment.

The rechargeable batteries can occasionally discharge during transit.
See Switch on Sequence on page 8 for details of the battery level
indicator.
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3. Introduction

The Crowcon Custodian is a portable gas detector which can monitor up to
four gases simultaneously. It is designed to be carried or worn by individuals
working in hazardous environments such as confined spaces, and will give a
loud audible and bright visual alarm warning when preset concentrations of
gas are exceeded.

Detailed mechanical design features have resulted in an easy to service
instrument with sealing to IP66.

The user interface has been designed to combine the best features of ‘one
button operation’ for routine applications, with simple multi-button operation
for advanced functions. The shape of the instrument has been designed to fit
comfortably against the body and pose the least restriction to movement. It
can fit in a pocket, on a belt or a chest harness.

The detachable battery pack can be replaced in a hazardous zone for round
the clock operation. Rechargeable packs utilise environmentally friendly nickel
metal hydride batteries with a life of up to 1000 charge/discharge cycles.
These will power an instrument with one flammable sensor and three
electrochemical sensors for up to 14%2 hours. Dry cell (disposable) packs are
also available with a life in excess of 26 hours. The life is considerably longer
if no flammable sensor is fitted (up to 80 hours with rechargeable battery and
up to 140 hours with dry cells).

The sensor module can be detached and replaced for easy field maintenance.
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Weight
Dimensions

Typical measuring
ranges

Typical alarm levels (3
per channel plus TWA
alarms for toxic chan-
nels)

Response times (T”)

Visual alarm indicators
Audible alarms

Display

Operating temperature
range

Humidity

Expected sensor life

4. Specification

500g (1.1lbs)
1565mm x 102mm x 52mm (6.1" x 4” x 2")

0-100%LEL flammable gas, 0-25% volume
oxygen, 0-50ppm hydrogen sulphide, 0-500ppm
carbon monoxide, 0-5ppm chlorine, 0-10ppm
sulphur dioxide, 0-1ppm ozone, 0-10ppm
nitrogen dioxide, 0-2ppm phosphine (normal
combination flammable gas, two toxic gases,
oxygen)

20%LEL and 40%LEL, 17%, 19% and 23%
oxygen, 10ppm and 20ppm hydrogen sulphide,
50ppm and 100ppm carbon monoxide instanta-
neous alarms and/or TWA alarms (STEL and
LTEL)

Methane 20 seconds, oxygen 10 seconds, typical
toxic gas 20 seconds

Ultra bright flashing red LED pair in ALARM
mode. Slow flashing green LED in NORMAL
mode.

Programmable from six different tones, 85dBA at
1 metre. Intermittent sound for discharged bat-
tery. Confidence blip (selectable).

Custom 7 segment high contrast LCD. 8mm
character height for gas readings. Symbols for
low battery, TWA alarm, blocked pump, peak
hold, and password protection. Bright backlight.
-20°C to 50°C (-4°F to 122°F)

0-95% RH, non-condensing
Pellistor 5 years, toxic gas 3 years, oxygen 1 year
(see page 25)
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Detachable battery pack

Aspirator/electric pump

Safety Certificate Nos.

Approval code (Europe)

(USA & Canada)
Standards (Europe)
(USA & Canada)
RF Immunity
RF Radiation

Battery charging

1.1Ah nickel metal hydride rechargeable: typical
life 14%2 hours diffusion mode, 12 hours
pumped. AA size alkaline replaceable: typical
life 26 hours diffusion mode, 21 hours pumped
Manual bulb type with 2m of hose, non-
absorbant, hydrocarbon resistant. Internal
electric pump option with auto on/off.

Instrument: Ex95C2349

Flam sensor block: Ex95Y1350

Battery pack: Ex95C2348X*
Instrument: EExia lIC T4 (T _ =55°C)
Flam sensor block: EEx d IIC T4

Battery pack: EExia lIC T3/4*

Class 1, Division 1, Groups A, B, C and D.
EN50014, EN50020, EN50018

UL 913, CSA 22.2

Tested to IEC801-3 and meets EN50082-1
Tested to EN55022 Class B and meets
EN50081-1

Dual rate charger for instrument or detached
battery pack. Fast charge in 6 hours, trickle
charge will not damage batteries. Input 100-250
VAC, 12-30 VDC.

tThe suffix X indicates a special condition whereby when disconnected, the
ingress protection (IP) rating of the battery pack is lower than when it is

aftached to the instrument.

*T3 applies to the Rechargeable battery pack at T_ ,=50°C, T4 applies to the
Non-rechargeable battery pack at T, ,=55°C.
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5. Operation
5.1 Switch-on Sequence
To switch on the instrument, press the main button.

The instrument tests all LCD segments, red alarm LEDs and sounder for 5
seconds, then displays the battery condition for 5 seconds before entering
Run mode. The battery condition is indicated by a flashing battery symbol and
a number representing the available battery voltage.

NOTE: For rechargeable battery packs, a reading below 4.5
indicates that the batteries require charging; for non-rechargeable
batteries, a reading below 4.5 indicates that the batteries

need replacing.

For the first 4-5 recharge/discharge cycles, rechargeable batteries
cannot hold a full charge. Therefore, the operation time is around 7'
hours for the first few charges.

The green ‘confidence’ LED will flash and the speaker bleeps (if programmed)
every few seconds to reassure users that the instrument is working and the
environment is safe. It is now ready to be used. Note the audible bleep may
be turned off using the SetCustodian program (see page 31).

NOTE: It is likely that the instrument may display an alarm
condition immediately upon entering the Run mode (indicated by a
flashing upper cursor). This is due to the sensors settling down after
switch on. In most cases, pressing the main button to cancel the alarms
after a few seconds will reset the instrument.

If the display shows an E number (eg.E2), this indicates that the diagnostic
routines have found an error, such as Calibration Expired. Section 14.1 gives
further details. Most E numbers can be accepted by pressing the main button.
NOTE: All units are shipped from the factory with the Functions Timeout
option enabled. This means that the instrument is locked in Run mode 2
minutes after switch on and thereafter no adjustments are possible. To
alter this, see Appendix A.
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5.2 Run Mode

The instrument displays each gas reading in turn for several seconds, cycling
back to the first. The channel displayed is indicated by a bar on the LCD
under the gas name on the label. To hold on a particular channel, press the
upper (») key to select the channel of interest. Note that the Run indication
disappears. Press the lower (®)key to return to Run mode. The display may
be blanked by a selection in the SetCustodian configuration program (see
page 35).

The display panel shown in figure 1 is for an instrument with 4 sensors fitted.
The sensor 1 reading is displayed first, indicated by the upper cursor, showing
18.7% LEL CH, (methane) present. After a few seconds the cursor moves to
the next position, and H,S (hydrogen sulphide) ppm (parts per

CH4 H2S CO 02 PEAK‘
%LEL PPM_PPM % HOLD

“igr

‘RUN "ZERO CAL SET SET
LO HI |

Figure 1 - Typical Run display

million) is displayed. A few seconds later it switches to sensor 3 which reads
ppm CO (carbon monoxide) then to sensor 4 which displays % by volume
oxygen. After completing this cycle, it returns to sensor 1 and repeats.

5.3 Instrument Settings

Unless otherwise specified, each instrument is set up and shipped from the
factory using the default settings. These cover password configurations,
alarm tones, logging period, confidence blip, and detailed operation of each
alarm point. Full details are printed on the Configuration Report supplied with
each instrument. Those functions which are changeable from the instrument
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front panel are described in Section 8. All options listed on the report can be
changed using the SetCustodian software described in Appendix A by
editing the c[Custodian serial number].set file (see Section A1.5).

5.4 Display Symbol Guide

Battery Low

When this symbol is flashing (accompanied by faster confidence bleeps), this
indicates that there is less than 20 minutes battery life remaining and the
instrument requires recharging. An instrument fitted with a non-rechargeable
battery pack may run for several hours in this condition.

e Internal Pump

This symbol indicates that the built-in pump is running. When this symbol
flashes (accompanied by a ticking noise) this indicates that the built-in pump
or airway is blocked. Once this occurs the pump will automatically be stopped.
Check that the flow adaptor and sample lines are free from water or dirt. Also
check the sensor filter behind the baffle plate (Figure 10, page 24).

Blockage can occur if a sampling pipe is lowered into a flooded cavity, as the
pipe may then suck up water, or if the air intake is blocked with a finger,
clothing etc.

Once blocked, the pump will not be restarted unless the flow adaptor is
removed and re-attached, or the instrument is switched off and on again or
the main button is pressed.

10
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ﬂ Password protection

Indicates that the function being selected cannot be accessed without a
password. This may be encountered when attempting to Zero, Calibrate, Set
Alarm levels or turn the instrument off. Password entry is described in Section
8.5.

A Peak hold

Indicates that the reading displayed is the highest level recorded since the
instrument was switched on or reset. For oxygen, Peak Hold records the
lowest value encountered. Peak Hold works for all gases simultaneously.
Selection is described in Section 8.1.

@ TWA alarm

This symbol flashes during an alarm to indicate that a time weighted average
threshold has been exceeded (See Section 7).

1
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6. Battery pack

6.1 Changing the battery pack

9 I

|©

\ / W N\ /
Figure 2 - Changing the Battery pack
1. Prise the clips away from the bottom of the battery pack.

2. Push the clips up towards the instrument to detach the hooks and
release them from the main body.
3. Pull the battery pack away from the instrument.

Refit a charged pack by reversing the above procedure. A CommsPod may
be fitted in the same way.

NOTE: Battery packs may be replaced but not charged in a hazardous
area. CommsPods may only be fitted and used in a safe area. The
rechargeable battery pack must only be connected to Crowcon detection
instruments recommended charging facilities in the non hazardous area.

6.2 Recharging
NOTE: Do not use the charger in a hazardous area!

Switch the charger on and place the instrument in the charger with the
charging contacts towards the rear.

12
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The charger’s red LED will light while the instrument is undergoing fast
charge. Full recharge from flat takes about 6 hours, during which it is normal
for the batteries to become warm. After fast charging, the red LED goes out
and the green LED comes back on: the batteries are now charged and

receiving a trickle current. The instrument can be used immediately or left on
charge indefinitely.

Battery packs can be recharged on their own without being connected to the
main instrument.

Nickel Hydride battery packs will self-drain in approximately 1 month.
Instruments should therefore be regularly recharged even when not in use.

No damage will occur if dry cell packs are inadvertently placed in the charger,
as no charging current will flow.

NOTE: The battery pack makes contact with the charger via the three
small silver contacts on the base of the battery pack. As these are diode
protected, no harm will come from these contacts being immersed in
water, or otherwise shorted, during use.

6.3 Dry cell packs (non-rechargeable)

Dry cells come in a distinctly marked battery pack to avoid confusion. To
change batteries, detach the battery pack from the instrument. Using the
Allen key provided, remove the bolts securing the battery retaining plate.
Replace the spent cells taking note of polarity indications.

NOTE: Cells may only be replaced in a safe area!

Use only the following battery types:
Duracell MN1500 LR6
Ever Ready Energizer LR6BA
Varta 4006

The use of alternative types will invalidate intrinsic safety approvals.

13
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7. Alarm types

For each gas channel, there are three instantaneous alarms; level 1, 2 and 3.
For toxic gas channels, there are also two time weighted average (TWA)
alarms which operate at short term (15 minute) and long term (8 hour)
exposure limits. Level 1 and 2 instantaneous alarms (referred to as SET Lo
and SET Hi on the display label) may have their thresholds adjusted from the
instrument kevpad (see Section 8).

All alarms may have their thresholds set via the computer interface (see
Section A1.4) and the following parameters may be set for instantaneous
alarms:

* Normally triggered on a rising level, alarms may be set to trigger on a falling
level as with oxygen deficiency alarms.

 Alarms may be latching, requiring manual reset, or self clearing when the
hazard has passed.

» Normal alarms cannot be cleared whilst the gas hazard persists. It is
possible to set them so they may be silenced (the red LEDs will continue to
flash). This allows the user to set a ‘pre-alarm’ warning at a low gas level and
a non-silenceable alarm at a higher level.

* Unused alarms may be deactivated.

If any alarm event is triggered, the red LEDs will flash and the sounder will
emit a loud tone. This tone is selected from a menu available to the
SetCustodian user (see Section A1.4).

The gas channel which has detected an alarm condition will be indicated by a
flashing LCD bar below the gas name. The gas value of a channel in alarm
will flash whilst it is being displayed. The instrument may be configured (A1.
5.3) to lock the display on the first channel to go into alarm. Pressing the main
button will restore RUN mode if previously selected.

If the TWA (time weighted average) symbol appears on the display, this
indicates that the total cumulative exposure to a toxic gas has been reached
for an 8-hour shift or a 15-minute ‘window’. Health & Safety regulations
require that workers should leave the hazardous area once they have
exceeded this dose. A TWA alarm cannot be manually reset. The main button
may be used to silence or clear certain instantaneous alarms as the
configuration permits.

14
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8. Keypad Functions

NOTE: Correct password entry or entering new zero, calibrate or alarm
level values will cause the instrument to produce a multitone audible
confirmation that the function has been carried out successfully.

8.1 Peak Hold
CH4 H2S CO 02 PEAK [CH4 H2S CO 02 PEAK
%LEL PPM_PPM % HOLD %LEL PPM. PPM % HOLD|
— ﬂ —
RUN ZERO CAL SET SET RUN ZERO CAL SET SET
LO HI , LO HI |
Figure 3 - Selecting Peak Hold Figure 4 - Peak Hold symbol

Peak Hold can be selected from RUN mode by pressing the upper

button until the bar appears under the PEAK HOLD label legend and the
displayed reading changes to three dashes(Fig 3). Press the main button to
make the double-peak symbol appear (Fig 4). (Pressing the main button
again at this stage restores normal display and removes the symbol.) Return
to Run mode or a specific channel with the cursor keys ®Or®-

The instrument will now display the peak reading of any sensor (lowest
oxygen reading) since the instrument was switched on. Press the main button
to clear the peak readlngs to current levels. (Press twice if alarm is
operating).

8.2 Zeroing instrument in clean air

Press the lower (®)key until the bar on the LCD moves from RUN to ZERO.
Press the main button to accept.

The instrument will zero all channels except oxygen which calibrates to 20. 9.
If purging with nitrogen, the oxygen channel will be zeroed.

15
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NOTE: The instrument must be in clean air before performing this opera-
tion.

If a key symbol appears on the LCD, a password is required to zero the
instrument (see Section 8.5).

If E2 appears (see Error messages, Section 14.1), the zero offset is too great
to be adjusted.

8.3 Calibrating instrument
Ensure the instrument reads zero (except oxygen) in fresh air.

Fit the flow adaptor as described in Section 9. From Run mode press the ®
key to progress the bar on the LCD to the Cal position.

Press the ® key to select the gas channel to be calibrated. Pass calibration
gas through the flow adaptor as described in Section 10. Press the (#)or (=)
keys to adjust the reading to match the known gas concentration. (Pressing
either )(®) cursor key at this stage will result in the adjustment being
scrapped.) Press the main button to accept the new value.

A key symbol may appear indicating that this value cannot be changed without
a password. If so, enter the password as described in Section 8.5.

If E3 appears (see Section 14.1) and the display does not achieve the desired
value, the gain is being set out of range indicating probable sensor failure or
incorrect calibration gas. Press the (® key to select another channel for
calibration or the ® key to step via the alarm view/change options back to
Run mode.

8.4 Viewing/Altering Alarm levels
Press the ® key until the Set Lo function is indicated. Press the ® key to

select the channel. The low alarm level for that channel is now displayed and
may be adjusted with the @/ keys. (Pressing either cursor key at this

16
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stage will result in the adjustment being scrapped). Press the main button to
accept the adjustment.

A key symbol may appear indicating that this value cannot be changed
without a password. If so, enter the password as described in Section 8.5.

Press the ® key to select another channel or the (®key to step via the SET
Hi option back to RUN mode.

The SET Hi funtion is identical in operation to the SET Lo function except that
it operates on the Level 2 alarm.

8.5 Password Entry

Access to the functions Zero, Calibrate, Set Lo, Set Hi and Switch off may
be restricted by the assignment of two passwords within the SetCustodian
configuration program (Section A1.4). The default configuration is as follows:-

Password 1 # & ® (® Protected function is ZERO

Password 2 ® (® (= @& Protected functions are ZERO, CAL,
SET Lo, SET Hi

If a protected function (eg zero, Fig 5(a)) is selected with the main button, the
display is cleared and the key symbol appears (Fig 5(b)) to prompt the user
to key in the relevant password. Enter the correct sequence of the@©® ®

CH4 H2S CO 02 PEAK CH4 H2S CO O2 PEAK
%LEL PPM PPM % HOLD %LEL PPM_PPM % HOLD

37 .

RUN ZERO CAL SET SET RUN ZERO CAL SET SET
LO Hi N Lo HI_

Figure 5(a) Selecting a protected function Figure 5(b) Password request

17
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CH4 H2S CO 02 PEAK
%LEL PPM _PPM % HOLD

;0000

CH4 H2S CO 02 PEAK
%LEL PPM_PPM % HOLD

. 377

RUN ZERO CAL SET SET
LO HI

Figure 5(c) Password entry

keys. As each key is pressed, a small ‘0’ appears (Fig 5(c)). After four key
entries, press the main button. The selected function will operate if the correct

RUN ZERO CAL SET SET
LO HI

Figure 5(d) Incorrect password

password was entered, otherwise a question mark appears (Fig 5(d)).
Acknowledge the error by pressing the main button.

Once a password has been successfully entered, it remains valid until the
instrument is returned to Run mode. All functions protected by this password

now take immediate effect when they are selected.

18
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9. Fixing Accessories

Three fixing accessories are supplied as standard.

1.

Optional fixing accessories available are: f Q
©

1.

2.

The transparent belt bracket may be fitted to
the rear of the instrument for use with a
normal trouser belt.

The pocket clip fits to the front of the
instrument which enables it to be worn as
shown in Figure 6.

NOTE: The battery pack fits inside the
pocket so that the sensors face outwards.

The two small brackets may be fitted to the back Figure 6 Pocket clip
of the instrument allowing the use of the shoulder
strap.

Waist belt

Carrying case complete with waist belt. This has
a transparent top cover through which the display
can be read and the controls operated. The
standard shoulder strap, as well as the waist belt,
may be fitted to the carrying case for securing the
instrument to the body. The flap on the front
allows access for the optional alarm earphone.

Chest harness (for use without carrying case -
see figure 7).

Figure 7 Chest harness

The full range of all accessories is shown on page 28.

19
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10. Using Pumped versions or Aspirators

For calibration of non-pumped (diffusion) instruments the optional aspirator is
required.

10.1 Diffusion Instruments

Figure 8 Aspirator flow adaptor

The Aspirator Flow Adaptor must be firmly fixed over the grille using the finger
screws. The Flow Adaptor has an inlet and outlet nozzle marked by air flow
direction arrows. The outlet must be connected to the hand aspirator bulb. A
consistent style must be adopted when using hand aspirators - Crowcon
recommend squeezing once per second to achieve a flow rate of
approximately 0.5 - 1 litre/min.

This adaptor may also be used on pumped instruments in which case the
internal pump will not run.

20
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10.2 Pumped Instruments

Al

Figure 9 Pump flow adaptor

The internal pump switches on automatically when the Pump Flow Adaptor
supplied is fitted over the grille. Ensure that the finger screws are firmly fixed.
Air is drawn in through the nozzle on the adaptor and exhausted through the
small nozzle below the sensor grille. In this configuration, the instrument
continuously samples air in its immediate vicinity. A sample tube up to 20
metres may be connected to the inlet nozzle for remote sampling.

Should the flow become restricted or the pump blocked due to ingress of
particles or water, the pump will automatically shut down and the PUMP
BLOCKED symbol will be displayed and a rapid series of warning beeps will
sound. To restart, remove the blockage, press the main button or remove and
replace the flow adaptor or switch the instrument off and back on.

NOTES:
1. If the blockage remains, the pump will not restart.
2, The instrument senses the presence of the flow adaptor using a

magnet moulded into the adaptor. Keep the flow adaptor away
from cassette tapes, floppy disks etc.

21
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10.3 Calibration Method

Pass calibration gas through the flow adaptor from a regulated cylinder. Use a
flowmeter and needle valve set after the regulator to set a flow rate of 0.5 - 1
litre/min. Pumped units should be fed gas from an unpressurised gas bag,
alternatively, a standard flow adaptor maybe used in which case the pump will
not run.

NOTE: Where the calibration gas may represent a toxic risk, it is
advisable to connect the outlet to an exhaust bag or fume extractor.

Typically, calibration gas must be applied for 30 seconds or more before the
reading stabilises to its final level. This reading may then be adjusted to the
desired level using the keypad (Section 8.3) or computer interface (Section
A1.4).

An automatic calibrator is available to streamline batch calibration.
NOTE: When calibrating with reactive gases such as H,S, care should be

taken to ensure that suitable materials are used for piping, valves, etc.
Examples of suitable pipe materials are given in the table below.

Pipe Material Compatible Gases

HDPE/Nylon Non-reactive gases (eg. CH,, CO)
PTFE/PVDF Highly absorbed gases (eg. H,S, Cl,, SO,)
Stainless steel (316) Non-reactive gases (special)

Ensure sensor apertures are free from dirt and check condition of filter
(Section 11.2) before calibrating.

22
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11. Routine checking

Custodian is designed to operate almost maintenance free under most
conditions. However, some small items of routine maintenance are
recommended .

11 .1 General

If used in dirty or hostile conditions, a regular wipe over with a damp cloth will
help in viewing the display and maintaining easy operation of the
pushbuttons. This is also recommended for the three small silver contacts on
the base of the instrument to maintain good contact for battery charging
(where rechargeable battery packs are used).

11.2 Sensor filter

This is manufactured from a water repelling material to protect the sensors
from immersion. If it becomes wet or dirty it may impede diffusion of gas into
the sensors, thereby degrading their performance. The filter is simply cleaned
by removing any flow adaptor that may be fitted, removing the sensor baffle
plate (see Figure 10, page 24), and washing in warm, soapy water. Dry
carefully, making sure the material does not rip or break, and replace.

11.3 Zero and Calibration

Because all gas sensors change their performance characteristics over time,
regular zero and calibration checks are recommended at the following
intervals:

Zero Every 1 month

Calibration Every 6 months

NOTE: Instructions on how to make these adjustments from the
instrument front panel are on pages 15 & 16, and via the SetCustodian
software on page 40.

Monthly Gas Check: Due to the safety nature of gas detection instruments, it is
recommended that sensors are regularly gas checked. Instrument sensors may
be adversely affected by certain environments (Section 13). A monthly test with
a known gas mixture will ensure the dependability of the equipment.

23
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If, during the course of a routine calibration, the instrument display indicates
E3 (Calibration failed), replace the sensor by following the instructions below.
In the case of a flammable sensor an E2 indication (Zero failed) may also
indicate a sensor failure. In this case check that the sensor is exposed to gas
free air and repeat the test.

12. Sensor Replacement

Remove the flow adaptor (if fitted). Remove the front grille which is secured
by two Allen headed screws (an Allen key is provided with each instrument,
and is located in the base of the main instrument. Access is gained by
removing the battery pack). The removeable filter may come away with this
component.

2 x 2.5mm

hex screws ﬁ }
Front Grill

Removable fitter

Remove the five screws securing
the inner grille and withdraw it from
@ @ ®/ the instrument.

Ol

Rotate the quick release fixings
which retain the sensor mounting
® pcb and detach it from the sensor

' LL LL @ plate.
Individual plug-in sensors may now
o o be replaced as required. If replacing
. W a toxic sensor, it maybe necessary

to replace the associated header

5 x pozidrive j&=

SCrews Inher grlll

Sensor
mouhting

== =5 pcb. If this is supplied with the
Header for i 0 iy spare sensor it should be
Sensorzé:[____,i = 23223: ;c’r exchanged with the header fitted to
g (Headers' resistors the socket on the marshalling pcb
are on near side of nearest to the sensor in question.
header PCE) /ﬂ/ NOTE: Ensure that the new
header board is fitted the correct

] way round. Refer to fig 10.
Figure 10 Sensor removal and replacement

When reassembling, ensure that all gaskets and filters are in good condition
and correctly fitted.

24
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13. Sensor Limitations

Custodian uses a catalytic flammable gas sensor which measures the
flammability of the gas. For this reason, readings displayed on the unit will be
unreliable over concentrations of approximately 120% LEL. Oxygen is
necessary for catalytic sensors to operate. It is advisable always to check for
oxygen concentration in addition to combustible gas concentration prior to
entering a confined space. Depleted oxygen levels below 10% will reduce a
flammable gas reading.

The performance of catalytic sensors may be permanently degraded if
exposed to silicones, sulphur containing gases (such as H,S), lead or chlorine
compounds (including chlorinated nydrocarbons).

Use of the unit in ambient temperatures above 50°C may cause unstable
readings due to inefficient temperature compensation at elevated
temperatures. Water saturated air conditions may prevent diffusion of the gas
through the sinter on the sensor housing due to build up of moisture.

Custodian uses electrochemical sensors which include a PTFE membrane.
This membrane is unsuitable for use in temperatures above 55°C, or in
saturated air conditions where condensed water build up on the surface will
prevent diffusion of the gas into the sensing chamber. Electrochemical
sensors are not wholly specific to their target gas and the presence of other
gases may cause the sensor to respond. Full details of cross sensitivities are
available from the Crowcon Sales department.

Use of high power radio transmitters in close proximity to the instrument may
exceed rated RFI immunity levels and cause erroneous indications. If such
problems are experienced, remove antennae to a reasonable separation from the
instrument (eg 30 cm).
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14. Troubleshooting guide

Symptom

Diagnosis

Remedy/check

Does not switch on

Battery flat

Recharge or replace
battery

Does not switch off

Password required

Alter configuration

Display blank

Display disabled

Alter configuration

No confidence bleep

Function disabled

Alter configuration

Reading when no gas
present

Zero drifted

Zero instrument in
clean air

Unstable/inaccurate
readings

Sensor failure

Recalibrate or
replace sensor

Does not talk to PC

CommsPod unpowered

Connect power

Cannot Zero, Span
or adjust alarms

"Functions Timeout"
enabled

Switch off and back
on or alter config.

14.1 Error codes

The instrument may display the following warning codes:
E1:

E2:

E3:

Calibration Expired: indicates that the period between regular

calibrations has elapsed.

Zero Failed: results from attempting to zero a channel exposed to gas.
The function request is aborted without effect.

Calibration Failed: the gain is being set out of range indicating
probable sensor failure or incorrect calibration gas. The gas reading
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E4:
E5:

E6:
E7:

is set as close to the desired level as the gain limiting software will
allow.

Sensor Overrange (displayed in place of a legal sensor reading)
High/low Temperature: gas readings may not be reliable at these
extremes. Sometimes occurs on initial switch on.

Electronic Hardware Failure: the instrument should be sent for repair.
Keypad fault.

Most of these warning codes can be acknowledged (cleared) by pressing the
main button.
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15. Accessories and Spare Parts Lists

15.1 Accessories List

C01451

DCO0104
DCO0101
DC0102
E01451

DCO0107
DC0108

C01097
C03141

DC0103
DCO0115
DCO0116
DCo0117
DC0118
DCO0119
C01296
DCO0105
DCO0120
DCO0121
DCO0122
DC0123
DCO0124
C01511

DCO0114
DCO0130

C01552

Waist belt

Carrying case, includes waist belt

Rechargeable battery pack, complete with batteries
Replaceable battery pack, complete with disposable batteries
AA size battery Alkaline, disposable, 4 required
Aspirator complete (pumped) with flow adaptor & tubing
Aspirator complete (non pumped) with flow adaptor, tubing, bulb
& pouch

Aspirator probe

6 metre drop line

Battery charger with no power supply, for 12V DC input
Battery charger with 230V power supply for UK only
Battery charger with 230V power supply for Europe only
Battery charger with 110V power supply for US only
Battery charger with 230V power supply - no plug
Battery charger with 110V power supply - no plug
Charging lead for vehicle lighter socket

Comms pod. Requires 12 volt power supply

Comms pod with 230V power supply for UK only

Comms pod with 230V power supply for Europe only
Comms pod with 110V power supply for US only

Comms pod with 230V power supply without plug
Comms pod with 110V power supply without plug

Alarm earphone with 1.5m of tubing

Chest harness

Transit Case (hard case complete with foam cut outs) for
Custodian-and all accessories

Autocalibrator Il (requires PC and Comms pod)

28



» CROWCON

15.2 Spare Parts List

DM0414
DMO0413
DMO0403
DMO0421
C01323

DMO0430
M04032
M04001

DCO0106
DCO0132
DCo0107
DC0128

DC0129

DS0103
DEO108
DS0118
DEO0101

DEO0703
DS0104
DMO0419
DMO0410
DMO0411
DC0111

DC0110
DM0409
DMO0412

Pocket clip

Belt clip

Battery pack clip

Finger guard

Shoulder strap

Shoulder strap bracket

Aspirator hose by the metre

Aspirator bulb

Aspirator pouch

Aspirator flow adaptor, fittings, bulb and tubing

Pumped flow adaptor, fittings and tubing

Main assembly kit for 3/4 channels (main/LCD board, LCD &
elastomers)

EXCHANGE ONLY *

Main assembly kit for 1/2 channels (main/LCD board, LCD &
elastomers)

EXCHANGE ONLY *

Analogue board (standard) Dual toxic, flammable, oxygen
Membrane keypad

Pump and mounting kit

LCD glass (2 elastomers required)

Elastomer (for DE0101)

Sensor board (standard)

Sensor pcb clips(set of 6)

Outer grill

Inner grill

Set of gaskets (set of 5, excluding sensor filter assembly)
Sensor filter assembly

Main body moulding

Top cover moulding

* The main assembly can only be supplied if the serial number is given
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Spare Parts List (continued)

DEO110
DEO113
DEO111
DEO112
DEO114
DEO115
DEO116
DMO0420
DM0207
C01009
DMO0701
DMO0703
DMO0702
DC0109
C01296
E01535
E01536
E015637
E01552
E01553
M03650
M03651
M03649

Sensor flammable 0-100% LEL methane

Sensor HS 0-50ppm hydrogen sulphide

Sensor OX 0-25% oxygen

Sensor CO 0-500ppm carbon monoxide

Sensor SO 0-10ppm sulphur dioxide

Sensor ND 0-10ppm nitrogen dioxide

Sensor CL 0-5ppm chlorine

Dummy tox/ox sensor for blank channels

Dummy flammable sensor for blank channels

Allen key 2.5mm

Instruction card small, for shoulder strap

Instruction card large, for carrying case

Instruction manual, English

SetCustodian software, 372" disk

Charging lead for vehicle lighter socket to charger
Power supply for charger/comms pod 230V for UK only
Power supply for charger/comms pod 230V for Europe only
Power supply for charger/comms pod 110V for US only
Power supply for charger/comms pod 230V no plug
Power supply for charger/comms pod 110V no plug
Outer grill fixing hex headed screw, 2 required

Battery pack lid hex headed screw, 2 required

No. 2 self tapping screw, 20 required
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APPENDIX A

SetCustodian Computer interface

A1.1 Introduction

SetCustodian is a Microsoft Windows™ based utility program for interfacing
with a Custodian gas detector. Using industry standard RS232 from the PC
serial port, the program allows full access to the instrument for routine
operations such as calibrating and advanced functions such as altering
passwords.

A1.2 Installation

The minimum hardware requirement for SetCustodian is a PC running
Windows™ 3.0 or later.

To install SetCustodian on the hard disk, insert the floppy disk supplied with
the Comms pod in drive a, click on the File menu in Program Manager, select
Run, and type a:setup as the Command Line The user will be asked to
choose the target drive. Setup will create a directory and program group
called Custodian. The installation procedure asks the user to select either
Com 1 or Com 2 as the port for Custodian connection to the PC.
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A1.3 Running SetCustodian

To run SetCustodian
proceed as follows.

Run Windows.
Double click on the ANULIELE  Feadie. Tut

SetCustodian icon . bl

which can be found in . .

the Custodian program group. Figure 11 Custodian Program Group

If the Com port selected during setup is unavailable, an alternative is offered.

Ensure that the instrument is fitted with a CommsPod in place of

the battery pack (see section 6.1 on battery pack removal). The A—
CommsPod must be powered from a 12V supply such as the el
power pack for the Custodian charger, and the serial lead must  SetCustodian
be plugged in to the computer serial port.

NOTE: The intrinsic safety certification does not
permit this operation in a hazardous area.

L

]

Figure 12
SetCustodian icon

Switch on the instrument.

A1.4 Using SetCustodian

Files Datalink Edit Adjust Help
SetCustodian is used for FILE EDIT d

modifying the way the

instrument is setup performing zero Figure 13 Status bar
and calibration functions altering alarm

setpoint values and uploading data for use in LogManager (see Section A2).

NOTE: Some of these functions can be accomplished from the instrument
front panel (see Section 8).

The opening screen includes a Menu bar and a Status bar. Menu bar
functions are described below. The Status bar is in three sections labelled
FILE, EDIT and Custodian, where FILE represents data stored on the PC
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hard drive and saved as a .set file, EDIT represents the data that appears on
the screen when the Edit menu option is selected and Custodian represents
the data held in the instrument. A section coloured yellow indicates it is
inactive. A section coloured green indicates changes have been made. A
section coloured red indicates that changes have been made to the Edit
screens, but not copied either to the instrument or the saved file.

A1.5 Menu options

S > I
New This allows a new setup file to be created. To i"es
do this select New, then Edit from the main menu Lt
bar. When editing is complete, select Save from Open...
the File menu, and type in a file name, making Save
sure the .set file extension is saved. Save fis...
Print
Open... This allows you to open an existing file Quality Print
already saved on the PC. This can be edited, or -
. . Exit
copied to another instrument.
Save This allows you to save edited files. Figure 14 Files menu
Save As... This allows you to save edited files in a format other than

.set or to a different drive or directory.

Print This allows you to produce a hard copy record of the setup
information created in Edit (this will be similar to the Configuration
Report originally supplied with the instrument). This will be printed on
the default printer connected to the PC. If a high quality font (similar
to the original Configuration Report) is required for a better
presentation, click the Quality Print command.
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A1.5.2 Datalink Datalink
Upload

Upload This allows you to transfer setup data Download
from the instrument to the PC. This data can Eea d Gas
then be edited to modify the way in which the N
instrument operates. Next Cal
Upload Log

Download This allows edited data to be
tranferred from the PC to the instrument. Figure 15 Datalink menu

Read gas This produces a “snap shot” of the instrument gas
readings. This can be used, for example, to check that the sensors
have returned to zero after a calibration.

éeiCu;Iod‘i‘én
Files Datalink Edit Adjust Help
FILE

Channel Values Units
1 Methane 0.0 LEL
2 H2S 0.0 pPpm
3 co 0.0 ppm
4 Oxygen 20.8 %Vol
Figure 16 Read Gas display screen
Next Cal This indicates the number of days left before the next

calibration is due. The calibration time is pre set to 26 weeks in the
Next Calibrate box in the Set Parameters screeen (For initial
shipment, calibration time is set to 32 weeks). After calibration, the
instrument will count down in days and when the time has elapsed,
the instrument will display the E1 (Calibration Expired) warning during
the switch on routine. Calibration times can be set to a different time,

but will only affect the instrument after calibration has been carried
out.
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Upload Log  This tranfers logged data stored in the instrument to the
PC for viewing in LogManager (see Section A2).

A1.5.3 Edit

Selecting this option will cause the Set Parameters screen to be displayed.

Set Parameters

.

Seconds

Twotone |%] TWA

~ Passwords

Zero Zero

[ calibrate Calibrate
[ Alarms B4 Alarms
O] ox O o

Functions timeout
<] Confidence Blip
24 Digplay Alarm

Mext calibrate Weeks

Figure 17 Set Parameters dialog box
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Display mode This can be selected as Full or No display. Selecting the
No display option will cause the LCD to remain blank at all times,
even under alarm conditions.

NOTE: If No Display is selected it is strongly advised that the
Confidence blip is selected On (see below). With both of these options
selected Off, the user has only the flashing green LED, under normal
conditions, to indicate that the instrument is operating.

Alarm sound This allows the different type of alarms to be programmed
with different sounds. Programming a particular sound for a Level 1
alarm, for example, will cause that sound to be activated for any Level
1 alarm that occurs, regardless of the gas. The 'silent' alarm sound
option (visual only) is only available on Level 1 alarms for safety
reasons.

For a computer simulation of the available sounds, select a sound in the Level
1 alarm box and click on Test.
NOTE: Use only the Level 1 option to Test sounds.

Logging period This sets the frequency with which the instrument
stores logged data. The log operates on a rolling basis, so that when it be-
comes full the oldest data in the log will be deleted and replaced by current
data.

Note: For an instrument with the logging period set to 60 seconds, the
log will fill up in approximately one week.

Passwords These are used to prevent unauthorised adjustments
being made to the instrument (for further information on use of
passwords, refer to Section 8.5). The Set Parameters screen in
Figure 17 shows that Password 1 will be required prior to making a
zero adjustment and Password 2 will be required prior to adjusting
zero, calibration or alarms. Clicking on any of the boxes will cause the
option to toggle on or off.

The default passwords are:
Password 1 () & ® ®
Password 2 () ® = @
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To change these, click on the Password 1 or Password 2 box and the
following screen appears

Press left four keys in sequence to set the
password. Cancel will retain the cunrent password.

Password level 1

Figure 18 - Password entry screen

Clicking on the four buttons in order will cause the new password to be
created.

NOTE: Any single button can be pressed more than once.

Functions timeout  With this option selected, the instrument is locked in
Run mode 2 minutes after switch on. This is to prevent accidental
erroneous adjustments being made during normal operation.

Confidence blip This switches the audible confidence blip on or off
(refer to the Display option above).
Display Alarm When selected, causes the instrument to lock its
display on the first channel to go into alarm.
Next calibrate See Next Cal on page 34.

Pressing Finished will store any changes made and return you to the main
SetCustodian screen.
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Clicking on the Channels box will cause the Setup Channels screen to be
displayed. To select a particular channel, click on the channel “page” at the
top of the screen.

Gas

g Setup Channels

ey ¥cne

Range Units

[H2s 2|

[0-50 |ppm [E|

Time Weighted Averages

Short term level Long term level

 Alarm 1 CAlarm 27— | [Alarm 3
B4 Active B Active [ Active
B Rising Alarm | | [X] Rising Alamm | | [ Rising Alarm
4 Latching X Latching ] Latching
< Can Mute [] Can Mute ] can Mute
[10.0 | [20.0 |
Value VYalue Value

Figure 19 Setup Channels dialog box

Gas, Range and Units are selected from pull down menus.

NOTE: These options are factory set and are used for displaying data in
LogManager and setting calibration limits. They are determined largely
by the sensors fitted in the instrument and correspond to the upper
label on the instrument display. These options should not be adjusted
without consultation with Crowcon or an authorised Distributor.
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Time Weighted Averages (TWA) These are also factory set to reflect the
Health and Safety requirements of the country to where the
instrument is delivered and only apply to toxic gas channels. Short
term level is the 15 minute exposure level and Long term level is
the 8 hour exposure level.

Alarm 1, 2 and 3 determine the operating modes for each alarm. Click on
any of the boxes to toggle on or off.
NOTE: Alarm 3 can only be configured using SetCustodian. All Alarm 3
settings are defaulted to Off and cannot be accessed from the instrument
front panel.

Active When selected, the alarm will operate

Rising Alarm Always selected On, except for oxygen deficiency
alarms, which are triggered on a falling
concentration.

Latching When selected, requires the alarm to be manually

reset, by pressing the Main button, after the alarm
condition has passed.

Can Mute When selected, allows the audible alarm to be
cancelled with the alarm condition still present.
Value Sets the point at which the alarm trips
NOTES:

1. The number entered in the Value box must be between 5% and 100%
of the number in the Range box, and can be entered to one place
of decimal (for example, if the Range is 0-50, the Value can be
between 2.5 and 50.0).

2. Itis not advisable to set Alarm Values for flammable gases higher
than 60.0.

Pressing Finished will store any changes made and return you to the Set
Parameters screen.
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A1.5.4 Adjust

Adjust

Zero Selecting this option displays a dialog rate
box allowing you to zero all channels or select
one. Clicking on OK will zero the selected Clear Log
channels and produce a confirmation message
that zero has been sucessfully completed. Figure 20 Adjust menu

NOTE: Only carry out this operation in clean air.

= Zero Channels

, Zero one or all channels

H2S E

Figure 21 Zero Channels dialog box

Calibrate Select the channel to be calibrated and enter the
concentration value of the calibration gas, as shown on the side of the
cylinder. Ensure that the gas has been flowing for at least 30 seconds
and click on OK. This will produce a confirmation message that
calibration has been sucessfully completed.

NOTE: For full calibration instructions, see Section 10.3.

Clear Log Selecting this option displays a Warning box asking for
confirmation. Selecting OK will clear all logged data in the instrument.
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Calibrate Channels

Calibrate a channel
Calibration gas value

Figure 22 Calibrate Channels dialog box
A1.5.5 Help

Help

Help provides the information given in this manual in an easy Help

to use on screen help. m

About displays an information box giving the
version number and publication date of
the SetCustodian software.

Figure 23 help menu

\I;igure 24‘About screen
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A1.6 Using SetCustodian - An Example

Problem

Your Health and Safety Manager has decided that a third level of alarm on
flammable channels is desirable, set at 50%LEL, non-latching, non-mutable
with the “Stair” audible warning.

Solution

Plug the instrument into the CommsPod, ensuring that the serial cable is
connected to the correct serial port on the computer.

Switch the instrument on.

Launch the Custodian Program group by double clicking on the group icon.
Open SetCustodian program by double clicking on the program icon.

From the Datalink menu, select Upload.

Click on Edit to display the Set Parameters screen.

In the Level 3 alarm sound box, select “Stair” from the pull down menu.
Click on Channels to display the Setup Channels screen.

Select Channel 1 (this is always the flammable channel).

Click on Active. Ensure that Rising Alarm is selected On, Latching is
selected Off and Can Mute is selected Off.

In the Value box, type 50.0.
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Click on Finished to return you to the Set Parameters screen.
Click on Finished to return you to the main screen.

From the Datalink menu, select Download. When completed, the screen will
display a confirmation message.

NOTE: If the setup file for that instrument is saved on the computer hard
drive, select Save from the Files menu, select the file (normally saved as
c[Custodian serial number].set) and click on OK. For example, an
instrument serial number 0000247 will correspond to file c247.set.
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A2. LogManager o
To use LogManager, it is necessary to

first upload the log. LogManager

Figure 25 LogManager icon

From the SetCustodian Datalink menu, select Upload, then select Upload
Log. The screen will display a Save File screen. This asks you to name the
log file. Either create a name by typing it into the File Name box (replacing
the asterisk) or by selecting an existing file (this will append the new data to
the end of that file).

Once a logged data file has been

saved on disk, it may be analysed »
using LogManager. Launch the
program by double clicking on the
LogManager icon (Fig 25).

File Convert View About

Figure 26 LogManager menu bar

Select Open Log... from the File menu (Fig 27).
Select the file of interest (anyname.log) by typing the

filename or clicking on a name from the list. Click OK. _

Files
Data is presented graphically with an individual coloured Open Log...
trace for each gas. As the mouse pointer is moved Save fis...
around the screen, the gas level and event time are Print Table
displayed in the upper left corner. An example is shown Quam_y Print
in Fig 28, but as a negative image for clarity. A vertical -
dotted line indicates that the Custodian Exit
has been switched off for a period during
the log recording. Figure 27 LogManager File menu

Use the horizontal scroll bar to move along the time axis. Gas values are
scaled according to the maximum range on any channel shown. In order to
see detail on a low range channel (eg 25ppm H2S), it may be advantageous
to turn off the traces of any high range channels (eg 500ppm CO). This is
achieved by selecting the View menu (Fig 29) and clicking on channels to
turn traces on or off.
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LogManager- 1111.LOG

File Convert View About

T [ T
200

T
200

|
100

.5

T ] I T I T

Divisions 30.0 minutes Fri Jul 26 09:59:32 1996
Scan Rate 60 seconds

L

Figure 28 LogManager View screen

A tabular listing of the current log file is available
by selecting Print Table from the File menu. The View
listing is directed to the default printer. Use
Windows Control Panel - Printers to select the < Hod Metlane
default printer. The chart may be printed directly by v Green H25
selecting the Print Graph command. v Yellow CO

' v Blue Oxygen

A2.1 Spreadsheet Files LogManager View menu

_For detailed analysis and presentation of logged data, files should be
converted to comma separated variable (.csv) format and then

imported into a proprietary spreadsheet program (eg Microsoft Excel, Lotus
123).

Select Save as... from the File menu and save the current logged data as
[anyname].csv. By default, this selection converts the entire file to .csv
format.
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LogManager uses the
Windows Country setting
to select between comma From reading number
and semi-colon data sepa-
rators. If you wish to pro- To reading number
duce files with comma data i
separators, regardless of (] Produce true CSV file.
PC settings, select the
Convert menu and check
the box marked ‘Produce
true CSV file'.

This dialog box also
enables a user to convert
just part of the data file
by entering the start and
end reading numbers. By default, the complete file is selected. Reading
numbers can be determined by placing the cursor at the appropriate point on
the graph and noting the reading number displayed in yellow at the top of the
screen.

ﬁi

Figure 30 LogManager Convert dialog box

A tabular listing of the current log file is available either by selecting Print
from the File menu or opening the relevant .csv file in a spreadsheet.

A3. ReadMe.Txt

Double clicking on this icon reveals general information on Custodian
software, plus any new information valid for that version.

46



» CROWCON

APPENDIX B

Default settings

Unless otherwise specified at the time of order, each instrument is shipped
from the factory programmed with the default settings. These are listed below.

Function

Display mode
Alarm sound level 1
Alarm sound level 2
Alarm sound level 3
Alarm sound TWA
Logging period
Password 1
Password 2

Password 1 protection
Password 2 protection

Functions timeout
Confidence blip
Calibration period

Option set

Full

Pulse

Two tone
Warble
Sweep

60 seconds

PO®®
CICISIC)

Zero

Zero, Calibrate, Alarms

On

On

26 weeks (32 for initial shipment)

Channel 1 (Flammable) Alarm Settings

Alarm 1
Active On
Rising Alarm On
Latching On
Can Mute Off

Alarm 2

On
On
On
Off

Alarm 3

Off
On
On
Off
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Channels 2 & 3 (Toxic) Alarm Settings

Active
Rising Alarm
Latching
Can Mute

Channel 4 (Oxygen) Alarm Settings

Active
Rising Alarm
Latching
Can Mute

Detection Range and alarm trip point settings

Flammable
Oxygen

H,S
co
SO,
cl,
HCN
)

3

Alarm 1

On
On
On
Off

Alarm 1

On
Off
On
Off

Range

0-100%LEL
0-25%v/v

0-50ppm
0-500ppm
0-10ppm
0-5ppm
0-25ppm
0-1ppm

Alarm 2

On
On
On
Off

Alarm 2

On
Off
On
Off

Alarm 3

Alarm 3

Alarm 1

20
19

10
50
2
0.5
5
0.5

Off
On
Off
Off

On
On
On
Off

Alarm 2

40
17

20
100
5

1
10
1

Alarm 3

60
23

50

500

10

5

25
Not used
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Service Record

Inst. Ser No: Location:
Due Act Zero Span Comments
Date Date
Ch1| Ch2 | Ch3| Ch4
Flam Oxy
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